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About Flare 

Flare is a comprehensive drug design platform including both structure-based and ligand-based methods. 

Capabilities in Flare V5.0 include: 

• Smart import and handling of protein-ligand complexes 

• Accurate and reliable protein preparation 

• Sequence alignment and superimposition 

• Accurate docking using Lead Finder™ 

• Advanced ligand-based conformation hunt and alignment 

• Pharmacophore building with FieldTemplater™ 

• Free Energy Perturbation simulations 

• Creation of custom parameters for the AMBER/GAFF and AMBER/GAFF2 force fields 

• Support for the Open Force Field 

• WaterSwap analysis for ligand and binding site energetics 

• Electrostatic Complementarity™ maps and score 

• Protein interaction potentials 

• Qualitative Structure-Activity Relationship analysis using Activity Atlas™ and Activity Miner™  

• Quantitative SAR models of regression and classification using Field QSAR and machine learning 

methods 

• Molecular Dynamics 

• Minimization of protein ligand complexes using XED and OpenMM 

• 3D-RISM water analysis  

• MD-based analysis of water thermodynamics with GIST  

• The Flare Python™ API 

Docking and scoring can be performed in Flare using BioMolTech's Lead Finder docking algorithm,1 now 

fully integrated in the GUI. The docking engine in Lead Finder combines a genetic algorithm search with 

local optimization procedures, which make Lead Finder efficient in coarse sampling of ligand poses and 

following refinement of promising solutions. Three different scoring functions are employed and optimized 

https://www.cresset-group.com/flare/
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for the accurate prediction of 3D docked ligand poses, protein-ligand binding energy and rank-ordering of 

active and inactive compounds in virtual screening experiments.  

Ensemble docking is a module of Flare for considering active site flexibility when alternative active site 

conformations of the same protein are available. Docking is performed within a workflow which enables 

the inclusion of multiple proteins in the same docking run, each corresponding to a different conformation 

of the active site.    

In both traditional and ensemble docking experiments, template docking is useful when you know the pose 

of a ‘template’ ligand and wish to use this information to bias the docking results for congeneric 

compounds. The molecules to be docked are aligned by substructure to the template ligand, and the 

aligned conformation is used to seed the docking run, generally leading to improved docking results.  

Covalent docking is a module of Flare for predicting the binding pose and interactions of covalent 

inhibitors, a class of ligands which derive their activity by forming a covalent bond with the target while 

making at the same time a network of non-covalent interactions with the active site. 

Ligand-based alignments can be used in Flare as a way to make meaningful comparisons across chemical 

series, and to generate sensible poses within a protein active site. Ligands can be aligned by using the 

ligand fields, by using shape properties or by using a common substructure. Using the fields gives a 

‘protein's view’ of how the molecules would line up in the active site, generating ideas on how molecules 

with different structures could interact with the same protein. Using substructure or common shape 

properties shows how the fields around a single chemical series vary with activity. The Conformation 

Explorer can be used to inspect and analyze conformation populations generated by Flare. 

In the absence of structural information about the protein target of interest, FieldTemplater can be used to 

build informative hypotheses of bioactive conformation, more informative and detailed than traditional 

pharmacophores. 

Free Energy Perturbation (FEP) calculations allow for the prediction of relative binding affinity changes 

within a congeneric ligand series. In these calculations a molecule is gradually converted into a structurally 

closely related analogue via a non-physical (‘alchemical’) pathway. By assessing the free energy difference 

(ΔΔG) between the end states of such transformations, accuracies of about 1 kcal/mol compared to 

experimental values can be achieved for large datasets. FEP in Flare is developed in collaboration with 

Julien Michel et al.2 at the University of Edinburgh. 

For dynamics and free energy calculations, Flare provides both the AMBER GAFF family of force fields and 

also the new Open Force Field. The Open Force Field version 1 release (‘Parsley’) is shipped with Flare, and 

it is simple to add new releases from the OFF consortium as and when they are available. For the GAFF 

family of force fields, it is possible to compute custom torsional potentials using a built-in QM module. 

WaterSwap3,4 is a Monte Carlo technique for investigating ligand-protein interactions, which allows the 

calculation of absolute protein-ligand binding free energies from first principles, condensed-phase 

simulations. This method, developed by Chris Wood et. al. at the University of Bristol, is fully integrated 

into Flare. Flare also supports advanced processing solutions for remote calculation. 

The Electrostatic Complementarity5 coloring and scoring functions within Flare are an extension of the 

protein interaction potential functions. They provide a detailed map and a quantitative score of how well 

the electrostatics of one or more ligand(s) matches that of the protein active site and can accordingly prove 

invaluable for the understanding of ligand binding, SAR and the design of new molecules that target the 

protein. 
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Flare calculates and displays protein interaction potentials (protein fields) based on Cresset’s XED force 

field.6,7 This methodology is extremely useful to understand the electrostatic environment of the active site 

of a protein, comparing protein and ligand electrostatics to improve new molecule design. Protein 

interaction potentials can also be used to analyze the active site of closely related proteins, to understand 

how subtle changes in the 3D conformation of the proteins, or in the protein sequence, can influence the 

electrostatic patterns of the active site. The analysis of the electrostatic patterns of a protein family using 

protein fields is also useful to inform the design of more selective ligands. 

Activity Atlas is a probabilistic method of qualitatively analyzing the Structure-Activity Relationships (SAR) 

of a set of aligned compounds as a function of their electrostatic and shape properties. The method uses a 

Bayesian approach to take a global view of the data in a qualitative manner. Results are displayed using 

Flare visualization capabilities to gain a better understanding of the electrostatics, hydrophobics and shape 

features which underlie the SAR of your set of compounds.  

Activity Miner is designed to enable the rapid navigation of complex SAR, highlighting key activity changes 

by analyzing activity and selectivity cliffs. Multiple views of the data are generated to help you find key 

molecule pairs in your SAR. For each pair, Activity Miner shows you how the electrostatic and shape 

properties differ, building an understanding of how to design better compounds with better properties. The 

different views enable you to focus on different aspects of your SAR. 

Predictive quantitative SAR models can be built in Flare using either built-in 3D/2D descriptors or custom 

descriptors using either Field QSAR (Flare's implementation of 3D-QSAR) or machine learning methods for 

regression and classification. 

Molecular Dynamics using OpenMM8 can be used to study the conformational changes of proteins and the 

stability of ligand-protein complexes. 

3D-RISM water analysis,9 based on the XED force field, investigates the location and stability of water 

molecules in your protein. This information can be used to identify energetically unfavorable ('unhappy') 

molecules which should be possible to displace from the active site by designing a ligand with the correct 

shape and electrostatic features. Incorporating energetically favorable ('happy') water molecules in the 

analysis of the active site using protein interaction potentials will lead to a better understanding of the 

electrostatic requirements of ligand-protein interaction, and to improved ligand design. 

GIST10,11 water analysis provides generates a detailed map of water thermodynamics in the vicinity of a 

solute such as a protein, which can be used to decide whether the water at a given location is favorable or 

not compared to the bulk distribution. This information can be used to assess the ‘druggabilty’ of a protein 

active site as well as the stability of bridging water molecules. 

The Flare Python API enables Flare functionality to be accessed from Python and for you to customize the 

Flare interface. Python scripts can be run from the Flare graphical user interface (GUI) or by the command 

line pyflare. 

1. O. V. Stroganov et al., Lead Finder: an approach to improve accuracy of protein-ligand docking, binding 

energy estimation, and virtual screening, J. Chem. Inf. Model. 2008, 48, 2371-2385 

2. M. Kuhn, et al., Assessment of Binding Affinity via Alchemical Free-Energy Calculations, J. Chem. Inf. 

Model., 2020, 60, 3120-3130 

3. C. J. Woods et al., A water-swap reaction coordinate for the calculation of absolute protein-ligand 

binding free energies, J. Chem. Phys. 2011, 134, 02B611,  

4. C. J. Woods et al., Rapid Decomposition and Visualisation of Protein-Ligand Binding Free Energies by 

Residue and by Water, Farad. Discuss. 2014, 169, 477-499 

https://doi.org/10.1021/acs.jcim.0c00165
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5. M. R. Bauer and M. D. Mackey,  Electrostatic Complementarity as a Fast and Effective Tool to Optimize 

Binding and Selectivity of Protein–Ligand Complexes, J. Med. Chem. 2019, 62, 3036 -3050 

6. J. G. Vinter, Extended Electron Distributions Applied to the Molecular Mechanics of some 

Intermolecular Interactions, J. Comput.-Aided Mol. Des. 1994, 8, 653-668 

7. J. G. Vinter, Extended electron distributions applied to the molecular mechanics of intermolecular 

interactions II - Organic Complexes, J. Comput.-Aided Mol. Des. 1996, 10, 417-426 

8. http://openmm.org/ 

9. R. Skyner et al., A Review of Methods for the Calculation of Solution Free Energies and the Modelling of 

Systems in Solution, Phys. Chem. Chem. Phys. 2015, 17, 6174-6191 

10. T. Lazaridis, Inhomogeneous Fluid Approach to Solvation Thermodynamics. 1. Theory J. Phys. Chem. 

1998, 102, 3531–3541  

11. C. Nguyen, M. K. Gilson, T. Young, Structure and Thermodynamics of Molecular Hydration via Grid 

Inhomogeneous Solvation Theory, ArXiv 11084876 Phys Q-Bio. 2011 

Supplied Binaries 

Flare functionality is delivered through a graphical user interface (GUI) with two interlinked binaries (Flare, 
FieldEngine). However, the GUI will call other binaries to perform specific tasks. 
 

Flare The main graphical interface for Flare 

pyflare Python scripts can be run from Flare GUI or by the pyflare command line tool. This binary 

gives you access to all Flare methods directly from the command line enabling you to 

automate and script your workflows. 

Scripts which allow Flare methods to be run from the command line are available in the 

'pyflare-scripts' directory within Flare's installation directory. You can find a description 

of each script and examples of application in the README file in the same directory.  

The scripts can also be downloaded from https://gitlab.com/cresset/flare-python-

pyflare. 

FieldEngine The calculation engine for Flare. FieldEngine is started directly by the primary interface to 

perform specific calculation tasks. By default, one FieldEngine binary is started for each 

CPU core on the host machine (but this can be reconfigured in the application 

preferences). The applications communicate with the FieldEngine using a TCP/IP protocol 

that can cause network access warnings in some situations.  

The FieldEngine process can be run on a remote machine with communication managed 

through a variety of methods including Cresset Engine Broker. 

Supported Platforms 

Note that Flare is not supported on Apple Silicon hardware. Support for macOS is limited to Intel based 

machines only.  

The minimum specifications are suitable for Flare Essentials and Flare Designer users working with a 

modest number of molecules. Flare Designer users working with large number of molecules and Flare 

Professional users (Flare LigandPro, Flare StructurePro and Flare Pro+ licensing levels) should regard the 

recommended specifications as a minimum. 

http://openmm.org/
https://gitlab.com/cresset/flare-python-pyflare
https://gitlab.com/cresset/flare-python-pyflare
https://www.cresset-group.com/software/cresset-engine-broker/
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Minimum specifications 

Hardware Specifications 

RAM 4GB 

Processor Intel i5 processor or equivalent 

Disk space 6GB 

Recommended specifications 

Hardware Specifications 

RAM 16GB 

Processor Intel i7 processor or equivalent 

Disk space 6GB 

Supported Operating Systems 

Flare is supplied as 64bit binaries for Windows®, macOS® and Linux®.  

Windows® macOS® Linux® 

Windows 10 macOS 10.15 

Intel based 

hardware only. 

Red Hat Enterprise Linux 7 

Alternative operating systems for Flare include macOS 11 and Red Hat Enterprise Linux 8. 

In addition: 

• Running FEP calculations is only supported on Linux 

• Local creation of custom parameters for AMBER/GAFF and AMBER/GAFF2 is only supported on 

Windows and Linux. 

GPU Calculations 

Flare’s Dynamics, GIST and FEP calculations require GPUs which support OpenCL or NVIDIA CUDA®.  

Flare V5 supports CUDA versions 9.2, 10.0 and 10.2 on Windows and Linux. To use CUDA, the NVIDIA GPU 

drivers must also be installed: the minimum required version of NVIDIA GPU drivers is detailed at 

https://docs.nvidia.com/cuda/cuda-toolkit-release-notes/index.html#title-new-features 

Cresset Engine Broker 

Flare calculations can run on remote machines with communication managed through a variety of methods 

including the Cresset Engine Broker. With Flare V5 the recommended version to use is Cresset Engine 

Broker V2.6. 

https://docs.nvidia.com/cuda/cuda-toolkit-release-notes/index.html#title-new-features
https://www.cresset-group.com/software/cresset-engine-broker/
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Installation 

Platform-dependent installation instructions are given below and at https://www.cresset-

group.com/support/support-resources/installing-desktop-applications.  

Windows 

1. Browse to the Windows folder of the Flare distribution media (or locate the installer in your Downloads 

folder) and double click the executable installer file.  

2. Follow the on-screen instructions. 

3. If you have a previous version of Flare installed, then this will be removed before installing the new 

version.  

Linux 

1. Install the packages required for running Flare: 

RHEL 6 & 7 and CentOS 6 & 7 
yum install mesa-libGLU libXScrnSaver 

RHEL 8, CentOS 8 and CentOS Stream 8 
dnf install mesa-libGLU libXScrnSaver libnsl 

Debian and Ubuntu 
apt-get install libglu1-mesa libxss1 

2. Browse to the Linux folder of the Flare distribution media (or locate the installer in your Downloads 

folder).  

3. Install the Flare re-locatable rpm package using one of the command lines below (where <vers> is the 

version number, <arch> is the architecture and <path> is install location (/opt by default): 

yum install cresset-flare-<vers>-1.<arch>.rpm 

or  

rpm -U [--prefix <path>] cresset-flare-<vers>-1.<arch>.rpm 

4. Alternatively, unpack the supplied tar.xz file to a suitable location (e.g. $HOME or /usr/local or 

/opt).  

macOS 

1. Open the supplied disc image.  

2. Drag the Flare icon onto the Applications icon to install the application in the Applications folder.  

Python Extensions and Scripts 

Python extensions are available to add useful functionality to Flare. These include for example extensions 

to export QSAR models data and fields samples. For more details and installation instructions go to  

https://gitlab.com/cresset/flare-python-extensions. 

Scripts to run Flare calculations from the command line or to integrate Flare into other applications are 

available in the 'pyflare-scripts' directory within Flare's installation directory and at 

https://gitlab.com/cresset/flare-python-pyflare. 

https://www.cresset-group.com/support/support-resources/installing-desktop-applications
https://www.cresset-group.com/support/support-resources/installing-desktop-applications
https://gitlab.com/cresset/flare-python-extensions
https://gitlab.com/cresset/flare-python-pyflare
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Start Flare 

Windows 

The install process places an entry in the ‘Start menu’ and a shortcut on your desktop.  

Double click the Flare shortcut to start the application.   

Alternatively, in the search box on the taskbar type Flare (the search panel opens automatically as you 

type). In the search results, click Flare to start the application. 

Linux 

If the installation was from rpm then select the shortcut in the Applications menu. 

Alternatively, in a terminal window type: 

/path_to_installation/cresset/Flare/bin/Flare 

where path_to_installation is the directory where the Flare distribution was unpacked. If Flare 

was installed from an rpm package keeping the default location, then the installation will be in /opt. 

macOS 

Navigate to the Applications folder and double click the Flare icon. 

Licensing 

To run Flare, you will require a valid license file which will be supplied by Cresset, usually as an attachment 

to an email. If you cannot locate your license file, then please contact support@cresset-group.com.  

To install a license, start the application and click on the ‘Install license’ button. Alternatively, the license 

file can be manually placed in one of the directories detailed at https://www.cresset-

group.com/support/support-resources/license-file-locations/.  

Changes to the Flare Python API 

Refer to Flare’s Python API documentation for the changes to the Python API. The documentation can be 

found in Flare’s installation directory. 

Changes in version 5.0 

• Ligand field calculations using the Cresset XED force field use a distance-dependent dielectric, for 

consistency with calculations performed on proteins 

• New Activity Miner module to enable the rapid navigation of complex SAR, using the concept of 

‘disparity’ or ‘activity cliffs’ to highlight regions in the SAR landscape where major changes have been 

observed 

o 3D field similarity of aligned ligands used a measure of distance 

o 2D similarity calculated with a choice of fingerprints can optionally be used as measure of 

distance 

o Multiple Activity Miner projects on multiple activity columns can be saved within same Flare 

project 

o Fully integrated within the Flare GUI 

mailto:support@cresset-group.com?subject=License%20enquiry
https://www.cresset-group.com/support/support-resources/license-file-locations/
https://www.cresset-group.com/support/support-resources/license-file-locations/
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• New Activity Miner tab grouping all functions for building Activity Miner models: 

o Create projects from selected ligands or all ligands in the Flare project 

o Activity Manager to select the columns containing activity data, and set up appropriate activity 

units and errors 

o Choose whether to use 3D field similarity of aligned ligands or optionally 2D similarity to 

calculate disparity 

o Change the color scheme for Disparity, Activity and Similarity 

• New Activity Miner windows to analyze and visualize relevant activity cliffs information: 

o Disparity Matrix: view the disparity information for all pairs of molecules in the Activity Miner 

project 

o Top pairs: view all molecule pairs that have a high disparity value for the specified activity 

o Activity View: examine the SAR around a particular compound 

o Cluster View: dendrogram showing the molecules in the Activity Miner project clustered using 

the currently selected similarity metric  

• New Qualitative and Quantitative Structure-Activity Relationships (SAR) model building module 

including the following methods: 

o Field QSAR using 3D descriptors, modeling the shape and electrostatic character of aligned 

molecules, to create a quantitative regression model. The interpretation of the model is aided 

by informative 3D visualization of electrostatic/steric coefficients and variance and contribution 

to predicted activity 

o Machine Learning for building quantitative regression and classification models 

▪ Choice of robust machine learning methods: Support Vector Machine, Relevance 

Vector Machine, Random Forests, k-Nearest Neighbor 

▪  ‘Automatic’ model building option to automatically run all the machine learning 

regression or classification models and save the model with the best statistics 

▪ Machine learning models can be built on Cresset 3D descriptors, modeling the shape 

and electrostatic character of aligned molecules, as well as 3D/2D imported descriptors 

and a choice of 2D fingerprints (kNN only) 

o Activity Atlas to generate qualitative 3D maps summarizing the SAR for the data series. Three 

different models are calculated:  

▪ Average of Actives: the average shape and electrostatic character of active molecules 

▪ Activity Cliff Summary: summarizes the activity cliffs information from the Activity 

Miner disparity matrix 

▪ Regions Explored: the shape and electrostatic regions that have been explored so far. 

Calculates a Novelty score for each molecule 

• New QSAR tab grouping all functions for building QSAR models: 

o Activity Manager to select the columns containing activity data, and set up appropriate activity 

units and errors 

o Partition the data set into a training set (used to build the QSAR model) and a test set (used to 

validate the predictive ability of a quantitative SAR model) 

o Build the QSAR model by opening a panel which enables to choose robust default settings for 

all model types 

▪ Access to advanced options to fine-tune the model building process 

▪ Custom-defined model building settings can be saved within the Flare project as well as 

exported/imported 

▪ Multiple QSAR models on multiple activity columns can be saved within the same Flare 

project 
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▪ Pre-defined role names in the Ligands table (Training Set, Test Set and Prediction Set) 

facilitate QSAR model building 

▪ QSAR models can be built from ligands in any role in the Ligands table 

o View informative 3D visualizations for Field QSAR and Activity Atlas models 

o Open QSAR Model window to visually compare different models 

o Calculate field kNN predictions which are not performed automatically as computationally 

expensive 

• New ‘QSAR Model’ dock window to analyze and visualize relevant QSAR model information, including 

the following tabs: 

o Activity: for regression models, shows the predicted vs. experimental activity plot for each role 

in the Ligands table; for classification models, shows the confusion matrices for each role in the 

Ligands table  

o Q2: plot of R2/Q2 vs. number of components/neighbors (Field QSAR and kNN) 

o RMSE: plot of Root Mean Square Error vs. number of components/neighbors (Field QSAR and 

kNN) 

o PCA: Principal Components Analysis plot to identify grouping of molecules and outliers in the 

descriptors space 

o 3D View: informative 3D visualizations for Field QSAR and Activity Atlas models 

o Notes: take model specific notes 

• New FieldTemplater module to build hypothesis of bioactive conformation, more detailed and 

informative than traditional pharmacophores. Enable the application of 3D techniques to target with no 

structural information 

• New GIST water analysis to assess the hydration of binding pockets and calculate the associated water 

thermodynamics by sampling explicit solvent distributions at the end of a molecular dynamics run 

• New Conformation Explorer to inspect and analyze conformation populations 

• New support for Electron Density maps, enabling download of maps at protein download and 

import/export of maps, and visualization of electron density information from the Surfaces window 

• New Protein Alternate Conformations window to review alternate conformations for protein and ligand 

atoms, enabling users to choose the preferred conformation before protein preparation in an 

interactive manner 

• Enhanced FEP calculations: 

o Significantly faster algorithm (up to 3.5 x speedup over previous version) 

o Graph creation improvements 

▪ Automatic addition of intermediate structures to optimise success rates 

▪ When working in production mode, ligands which do not contribute to the 

perturbation network are excluded from the calculation and can be removed 

o Automatic determination of optimal lambda schedules, requiring minimal user interaction and 

providing additional speed improvement 

o System improvements:  

▪ LangevinMiddleIntegrator combined with Hydrogen Mass Repartitioning to get stable 

4fs timesteps 

▪ Solvent box shape now defaults to truncated octahedron, more efficient than 

orthogonal  

▪ Solvent box buffer now defaults to a smaller value of 6Å, making calculations faster 

without affecting quality of results 

▪ Longer pre-equilibrations, now running for 500 picoseconds by default 

▪ Choice of explicit water models  
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o Support for larger datasets (up 500 molecules when using a star graph) 

o Clearer annotation of links affected by poor lambda overlaps 

o Option to manually set a custom lambda schedule for selected links 

o Improved 3D window visualizations within FEP projects 

o New commands in the FEP Project Home tab to clone and rename FEP projects, and hide links 

among ligands with known activity 

o Tooltip reporting number of GPU hours calculated/remaining 

o Option to force the re-equilibration of a ligand without clearing any completed links 

o Option to relax the requirement that ligands should be part of a cycle whenever possible, 

enabling the generation of ‘tree-like’ graphs 

o New check for duplicate ligands before starting a new calculation 

o FEP CPU calculations can now run locally 

• Enhanced molecular Dynamics: 

o Improved support for peptide ligands 

o System improvements:  

▪ Choice of explicit water models  

▪ New advanced options to set temperature, pressure, treatment of long-range 

electrostatics, non-bonded cut-off 

▪ LangevinMiddleIntegrator combined with Hydrogen Mass Repartitioning to get stable 

4fs timesteps 

▪ Solvent box shape now defaults to truncated octahedron, more efficient than 

orthogonal  

o Improved Contacts table to monitor favorable ligand-protein interactions: 

▪ Interactive: clicking on a ligand/protein atom label in the Contacts table highlights the 

atom in the 3D window, double-clicking focuses the 3D view on that atom 

▪ Table creation significantly faster 

▪ The table is now saved within the Flare project and can be exported 

o Images of the Dynamics plots can now be copied in the clipboard and saved in different file 

formats 

o Added support for post-translationally modified amino acids with AMBER 

• Enhanced minimization of ligands, proteins and protein-ligand complexes now also supporting 

OpenMM minimization using the AMBER GAFF/GAFF2 and Open force fields 

• Improved ligand-based alignment: 

o Improved Conformation Hunt and Align panel 

o Enhanced advanced options for alignment, now including: 

▪ Option to bias substructure alignment towards a specific substructure specified by a 

SMARTS pattern 

▪ Option to set relative weights to each reference used in alignment 

▪ Option to set relative weights to each field used in alignment 

▪ Additional ligand similarity metrics: Tanimoto and Tversky 

• Enhanced virtual screening of thousands of compounds, now including also scoring by QSAR model 

predictions 

• Improved protein preparation panel now enabling to: 

o Choose/create a role for extracted ligands 

o Remove water molecules outside of the active site 

• Improvements to docking and scoring: 

o New docking constraints definitions to map pi-stacking, cation-pi and salt-bridge interactions 
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o Expanded range of electrophiles that are auto-recognized in covalent docking 

• Improved editing of ligands: 

o New ‘Optimize Alignment’ button in the Editing Tools menu to gently optimize the alignment of 

the ligands being edited to up to 9 selected ligands, optionally using a selected protein as an 

excluded volume 

o New ‘Clear Column Data’  button in the Editing Tools menu to clear all data associated with the 

ligand being edited 

• Improved open molecules panel now enabling to choose/create a role and add a role description for 

the ligands being imported 

• Improved export of ligands: 

o Multiple ligands with multiple conformations can now be exported to a single sdf file 

o Export of alignments/poses is now available also for selected molecules 

• Significantly improved import and export of CSV files, now enabling to add/merge data into the Flare 

project, and to export CSV data for selected ligands only 

• Improved access to Cresset Flare Python extensions and scripts, now distributed within the main 

package and available for all users without a separate download 

• Improved Protein Structure Checker now also reporting gaps in protein structure 

• Updated Python to version 3.6.13 

• Updated OpenMM to version 7.5.0 

• Updated OpenFF versions to include Parsley V 1.0.1, 1.1.1, 1.2.1, 1.3.0 

• Updated RDKit to version 2020.09.4 

• Updated Lead Finder to version 2104 build 1 

• Updated Build Model to version 2104 build 1 

• New features and improvements to the Ligands table: 

o Roles: 

▪ New button near role name to select all ligands in a role 

▪ Double-click on a role name to rename the role 

▪ Roles can be moved up and down from the role right-click menu 

▪ Duplicate roles from the role right-click menu 

o Columns 

▪ The background of columns in the Ligands table is now color-coded according to the 

radial plot property profile for that column 

▪ The Ligands table can now by filtered also by index 

▪ Custom columns can be used to set ligands title 

• New and improved Flare Preferences: 

o New Appearance preferences options to: 

▪ Set the color of steric/electrostatic variance and favorable/unfavorable electrostatic 

contributions for Field QSAR 

▪ Set the color of the conformation energy gradient and conformation torsion frequency 

gradient for the Conformation Explorer 

▪ Hide smaller field points 

▪ Disable the energy plot when rotating a molecule bond during editing 

o Improved display of ligand field points by setting the default field scaling from radius to area in 

the Flare Appearance preferences 

o New Calculations preferences option enabling users to set the directory where to save the 

results when creating custom GAFF/GAFF2 torsion parameters 

o New General preferences option to set the download URLs for electron density maps 
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o New Table preferences option to color the columns in the Ligands table according to their fit to 

the radial plot property profile, and set the color scheme 

• New features and improvements for the Flare tab menus 

o Reorganized all tab menus to make them more intuitive and efficient 

o Home tab: 

▪ New ‘Focus’ button to focus the 3D View on the selected ligand/picked atoms 

▪ New ‘Search Molecules’ interface enabling rapid identification of ligands, proteins, 

proteins residues and protein sequences through text, SMILES and SMARTS search 

▪ New ‘Ligand Filters’ button to rapidly open the Filters window 

▪ New ‘Select’ menu to rapidly select the desired subsets of ligands and proteins 

▪ ‘Capture Scene’ button was moved from the View to the Home tab to facilitate use 

▪ Improved coloring of proteins and ribbons by temperature factor, now coloring also the 

ligands associated with the protein and showing the temperature factor range to 

facilitate set up 

▪ Improved ‘Contacts’ panel now also showing ligand interactions with metals 

o Ligands tab 

▪ Ligands can be now be created from SMILES 

▪ New ‘Plot’ button to create interactive plots for the columns in the Ligands table 

▪ New ‘Histogram button to create interactive histograms for the columns in the Ligands 

table 

▪ New ‘Copy to All Ligands’ button to copy the current ligand surface settings to all 

ligands 

▪ New ‘Set Role’ button in the Ligand tab to assign ligands to a chosen role 

▪ New function to assign ligands to roles based on their Murcko scaffold 

▪ New function to align the 2D image of all ligands in the Ligands table to the image of 

the selected ligand 

o Protein tab: Loop Modelling, Ramachandran and Contact Map extensions are now installed by 

default and accessible from the ‘Structure’ group 

o View tab: new ‘Depth of Field’ button giving control over camera’s aperture, enabling blurring 

of background objects 

o Help tab: new ‘Tours’ that guide users through available and customizable experiments 

• Protein surfaces: 

o Improved ‘Surfaces’ window now enabling import/export of electron density maps, and 

different types of actions on protein surfaces (show/hide, duplicate, export, delete, select 

associated protein) 

o Protein surfaces saved in the ‘Surfaces’ window can now be renamed 

o Option to color a protein surface according to residue 

o Improved generation of protein surfaces now including only atoms lining the active site 

• New option to hide/unhide proteins in the Proteins table 

Changes in version 4.0.2 

• Performance improvements to run ligand-based alignment, ligand minimization and docking 

experiments from the Flare GUI at a 10K scale 

• Fixed bug which prevented FEP calculations to work on GPUs set to PROCESS_EXCLUSIVE mode. 
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Changes in version 4.0.1 

• Fixed bug in the calculation of predicted G values when running FEP in benchmarking mode, which 

may have led to an overestimate of the statistical performance (in terms of R2 and MUE) for the project 

• Fixed bug which caused Flare to detect the CUDA drivers incorrectly on multi-GPU machines. 

Changes in version 4.0 

• New and improved force fields: 

o New Open Force Field (Parsley 1.1.1 or 1.0.1) for FEP, Dynamics and WaterSwap calculations, 

with a flexible implementation enabling users to easily update to the latest version 

o New Custom Force Field wizard to create AMBER GAFF or AMBER GAFF2 custom parameters 

for ligands of interest, based on Quantum Mechanics calculations 

o New Parameter Explorer, showing a report for the available custom parameters for GAFF and 

GAFF2 

• New and improved features for FEP calculations: 

o Faster algorithm, with up to 20% improvement in performance 

o New ‘Star-graph’ networks, optimized to explore how changes to the selected molecule in the 

center of the graph affect activity 

o New ‘Production’ mode, which adjusts the perturbation network to prefer direct links to 

molecules with known activity, and uses available experimental activity data in the final 

computation of ligand ΔG values, enabling more precise calculations 

o New quick-mode, to run the FEP simulation using only single-way calculations, considerably 

speeding up the calculations 

o New Atom Mapping viewer, to inspect and modify the current atom mapping for two ligands 

connected by a link 

o New FEP resources calculator, providing a detailed report on the total number of ligands, links, 

perturbations and lambda windows in the project, as well as an estimate of the number of GPU 

hours required to run the experiment 

o New, optimized algorithm for calculating predicted activities and associated errors 

o New option to specify a directory for storing the intermediate results of the FEP calculation 

o New option to transfer equilibrated protein-ligand complexes back to the main Flare project 

o New visualization of protein solvent-excluded surfaces  

o Improved algorithm for inclusion/exclusion of links in the analysis of results 

o Improved mapping of H atoms, now taking into account 3D coordinates 

o Improved FEP project creation GUI, now enabling to import activity values in different units, 

automatically transforming them into G values 

o Improved logging of FEP calculation results 

o Improved definition of water boxes, now generating smaller, more effective water boxes 

o Highlighting of unmapped atoms when links are selected 

• New and improved features for Dynamics, including: 

o New Analysis button, opening the Dynamics analysis widget to view: 

▪ RMSD plot 

▪ Plots of physical properties: potential energy and temperature of the system, box 

volume and density. These plots can be exported as a .csv file 

▪ Contacts table, reporting contact statistics for favorable ligand-protein interactions 

observed during the simulation 
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▪ Measurement plots, which can be created for each measurement (distance, angle or 

torsion) shown in the 3D window. These plots can be exported as a .csv file 

o New capability to resume a completed dynamics experiment, adding more calculation time to 

the simulation 

o Improved, interactive RMSD plots, also showing additional information such as protein name 

and number of visible atoms 

o Improved handling of storing/retrieving dynamics trajectories 

• New Structure Check function, to check the selected protein structure for potential problems which 

could not be resolved during protein preparation 

• New and improved protein preparation advanced options: 

o Option to keep the ligand unchanged during protein preparation (off by default) 

o Option to fix 1- and 2- residues gaps (on by default). Larger gaps can be fixed using the FREAD 

Python extension 

o ATP/ADP are now correctly recognised as cofactors 

• Updated Python to version 3.6.9 

• Updated OpenMM to version 7.4.1 

• Updated RDKit to version 2019.09.3 

• Updated Lead Finder and Build Model algorithms  

• Improved ligand minimization, now enabling the minimization of multiple ligands at the same time and 

now reporting the RMSD of the minimised ligand position compared to its pre-minimised starting co-

ordinates 

• Improved handling of docking constraints, now enabling to set a maximum tolerated constraint penalty 

which must not be exceeded for the pose to be retained 

• GUI new features: 

o Option to color ligand and protein atoms by XED partial charge 

o Protein surfaces can now be shown as wireframe (mesh) 

o New ‘Conf Energy’ column in the Ligands table capturing the relative conformation energy for 

each generated conformer relative to the lowest energy conformation 

o Option to export of ligands together with their associated protein 

o Keyboard shortcut ‘V’ for setting favorites 

o New Color Sequences button to change the background color of residues in the Proteins and 

Alignment tables to match the color shown in the 3D window, or the secondary structure of the 

protein 

o New option to manually cap terminal residues or residues near a gap from the right-click menu 

o Labelling of atoms according to AMBER type 

• GUI improvements: 

o Improved display of relevant protein information in the protein Title tooltip, now reporting the 

resolution for the imported protein, the total number of residues and heavy atoms 

o Improved display of salt-bridge interactions 

o Improved ‘Send to Blaze’ functionality, now providing information about how to connect Blaze 

to Flare 

o Improved handling of error messages now giving hostname information to help debugging on 

large clusters 

o Improved export of high resolution pictures of the 3D window with either opaque or 

transparent background 

• Bug fixes: 
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o Fixed bug which occasionally generated unrealistic poses when covalently docking ligands 

containing a cis amide 

o Fixed bug which occasionally made covalent docking fail to generate the correct stereoisomer 

for the docked ligands 

o Fixed bug which occasionally caused the Home tab to disappear 

o Other bug fixes 

Changes in version 3.0 

• New Free Energy Perturbation (‘FEP’) module in the Ligand tab, to predict relative binding affinity 

changes within a congeneric ligand series.  

• New ‘Covalent Docking’ module in the Ligand tab, for predicting the binding pose and interactions of 

covalent inhibitors 

• New template docking option available for standard and ensemble docking experiments, useful in 

those cases where the pose of a ‘template’ ligand is known and can be used to bias the docking results 

for congeneric compounds 

• New ‘Dynamics’ module in the Protein tab, using OpenMM to study the conformational changes of 

proteins and the stability of ligand-protein complexes 

• New ‘Conf Hunt and Align’ module in the Ligand tab, to perform ligand-based alignment 

• GAFF2 force field now available for 3D-RISM, WaterSwap, Dynamics and FEP 

• New Tiles view showing a compacted version of the Ligands table 

• New Sequence Similarity table reporting the results of sequence alignment in a matrix format 

• New and improved editing of ligands, proteins and waters in the 3D window, including all the Molecular 

Editor functionality of previous Flare releases, enabling at the same time full access to ligand and 

protein selection and appearance changes functionality. Also including:  

o Full access to all the periodic table elements 

o New button to edit protein residue information 

o New button to fix and reorder protein residues based on current connectivity  

o New option to edit a selected portion of a molecule 

o Relative manual movements of proteins now possible 

• New functions and options for the Home tab: 

o Ribbon colors menu, to color protein ribbons independently from the color of carbon atoms, 

and to color ribbons by residue, protein sequence, protein chain and protein temperature 

factor 

o Option in the ‘Ribbon’ button to set ribbon transparency 

o Ribbons can now be displayed also for DNA and RNA 

o Atom colors option to color also non-carbon atoms with a solid color 

o Option in the Atom Pick panel to pick atoms by name 

o Option in the Atom Pick panel to find specific residue sequences 

• New functions and options for the Ligand tab: 

o ‘New’ button to create new ligands from scratch 

o ‘Constraints’ button for adding or removing docking constraints to picked protein atoms, or to 

set ligand constraints for alignment and virtual screening 

o ‘Send to Blaze’ button to run new Blaze searches from Flare 

o ‘Download Blaze Search Results’ button to retrieve the results of existing Blaze searches 

o ‘Remove all Tags’ option to remove all tags from selected molecules 

o  ‘Diff’ button to show field differences for two selected ligands 
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• New customizable option in the standard, ensemble, template and covalent docking calculation panels 

to set the number of independent docking runs for each ligand, keeping the best poses overall 

• New ‘Show Secondary’ button in the Proteins tab to show a colored line above the residue names in 

the Proteins and Alignment tables, corresponding to the secondary structure 

• New functions and options for the View tab: 

o ‘Synchronize Selections’ button to keep in sync the selection of ligands and associated proteins 

o Option to choose the screen to use for Full Screen mode 

o Option to set the stereo method for the current project 

• New Help tab to access Flare documentation and information, giving access to: 

o Flare manual and Flare Python Developers Guide 

o  ‘Tips and Tricks’ page on the Cresset website 

o Information about the Flare version and relevant licensing information, including the Flare 

license expiry date 

o Cresset website 

o Flare release notes 

o Online form to register to the Cresset newsletter 

o email to Cresset support 

o Generation of diagnostic data 

• New filter button in the Alignment table to show only protein chains belonging to the desired 

alignment group 

• New right-click options in the Proteins and Alignment tables, including: 

o Choose a specific protein chain to set the residue sequence numbering in the ruler 

o Select a protein’s associated ligands 

o Invert the current selection of proteins 

• New right-click options for the Ligands table, including: 

o Set ligand constraints for alignment and virtual screening 

o Select a ligand’s associated protein 

o Clear the protein association 

o Invert the current selection of ligands 

o Export selected docked poses and alignments 

o Convert conformation to poses 

o Choose any user column as the molecule title 

o Choose the column to use as a label in the 3D window 

o Set user column type (text/number) 

• New advanced options to disable small side chain movements and to remove atoms from residues with 

incomplete backbone during protein preparation 

• New right-click options for the 3D window: 

o Add custom labels/annotations to ligand and protein atoms 

o Select ligands and proteins 

o Add or remove docking constraints to picked protein atoms 

• New import and export of Flare Preferences from the command line 

• New Appearance Preferences options: 

o Customizable option to limit the maximum number of ligands to display, giving a warning when 

the maximum number of ligands is exceeded 

o Option to disable pink halo highlighting atoms under the mouse cursor 
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o Option to change the default green=good and red=bad colors for good/poor electrostatic 

complementarity, favorable/unfavorable 3D-RISM waters, favorable/unfavorable interaction 

free energies for WaterSwap into a custom color 

o Maximum copy picture size resolution can now be set to 10x 

• New Calculations Preferences panel, to set the maximum number of alignments to generate for each 

ligand 

• New Table Preferences panel, to customize visible/hidden columns in the Ligand table and 

visible/hidden tile items in the Tiles view 

• New option to use all available local CPUs, relaxing the 16-CPUs limitation in previous Flare releases 

• New Blaze Preferences panel, to set-up the communication with Blaze 

• Improved and faster XED minimization algorithm 

• Improved handling of metals in the XED force field – most common metals (Zn, Fe, Mg, Ca etc.) found in 

a protein environment should be modelled more accurately 

• Improved atom typing during protein preparation 

• Improved handling of DNA and RNA 

• Improved handling of larger datasets 

• Improved Electrostatic Complementarity algorithm, including: 

o Restricting the EC calculation to regions of the ligand surface which are in contact with the 

protein 

o Calculation of Electrostatic Complementarity scores for ligand alignments 

o Electrostatic Complementarity scores are now calculated against each associated protein for 

ensemble docking poses 

• Improved ‘Accurate but Slow’ and ‘Very Accurate but Slow’ docking calculation methods for standard, 

ensemble, template and covalent docking, now performing 3 independent docking runs and keeping 

the best poses overall 

• Improved ‘Score Only’ calculation method mode for standard, ensemble, template and covalent 

docking, now giving the option to disable pose optimization 

• Improved handling of conjugated bonds in Lead Finder 

• Improved docking processing panel, now including by default the ion and cofactors chains in the 

docking experiment 

• Updated AmberTools version to AmberTools 2019 

• Updated Lead Finder and Build Model algorithms  

• Updated Sire to version 2019.1.0  

• Updated RDKit to version 2019.03.4 

• Improved Contacts panel, including: 

o New contact definitions for weak H-bonds and salt-bridge interactions 

o Full control on the interactions to show, with fully customizable matrixes for favorable and 

favorable interactions 

o New option for keeping the matrixes for favorable and unfavorable interactions in sync 

o New option to show the interactions in bold style 

o New option to show only interactions between associated molecules 

• Improved Filters window, now including: 

o A new green/red toggle to control whether each filter is enabled or disabled 

o A new settings button enabling import and export of the set filters 

• Improved filtering options for text columns, now including ‘equal’, ‘not equal’, ‘containing’ and ‘not 

containing’ options 
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• Improved structural filters now including pre-defined filters for Ring, Aromatic Ring, Non-ring atom, 

Chiral atom, H-bond donor and H-bond acceptor 

• Improved Processing Preferences panel, including a completely redesigned GUI for setting and 

customizing multiple Cresset Engine Brokers, and a section to set local GPU processing 

• Improved PDB download widget now supporting multiple PDB download paths 

• Improved Radial Plots and Multi-Parameter Scoring, including: 

o New settings button in the Radial Plots Properties window, enabling import and export of the 

radial plot properties profile, and to restore the radial plot properties to default values 

o New option to specify whether invalid values for each property should be shown at the edge or 

at the center of the radial plot 

• Improved 2D display of molecules 

• Improved ‘Move to Protein’ button in the Ligand tab, now allowing to move a selected ligand to a new 

protein in the Proteins table 

• Proteins can now be sorted and reverse-sorted by protein title in the Proteins and Alignment tables 

• Improved way for drawing of sequence alignment constraints 

• Calculation and display of protein surfaces is now performed by default on visible atoms 

• Improved export of molecules with drag-and-drop, now exporting all Ligands table data as sdf tags. 

• Improved ‘Atoms’ button to show/hide atoms and bonds, now giving the option to show only picked 

atoms 

• Improved ‘Color by residue’ function, now coloring atoms and ribbons by residue type 

• Smoother transition across Storyboard scenes 

• Improved layout of all Flare ribbon menus 

Changes in version 2.0.1 

• Windows only release, to fix an issue causing an incorrect update of the 3D window. This issue only 

affects systems with an Intel GPU and drivers version 24.* or later on the Windows operating system. 

Changes in version 2.0 

• New Flare Python API enabling Flare functionality to be accessed from Python and customization of the 

Flare interface. Python scripts can be run from the Flare graphical user interface (GUI) or by the 

command line pyflare 

• New Python tab in the Flare GUI providing access to the Flare Python API functions within the Flare GUI 

• New Electrostatic Complementarity Scores, calculated for each ligand based on the associated protein 

and saved as columns in the Ligands table. These provide three alternative quantitative scores of how 

well the electrostatics of one or more ligand(s) matches that of the associated protein active site 

• New electrostatic complementarity surfaces for ligand and proteins, providing a detailed visual map of 

ligand/protein electrostatic complementarity 

• New electrostatic potential surfaces for ligands and proteins, colored according to the electrostatic 

potential calculated with the XED force field 

• New coloring of protein surfaces by secondary structure and Wimley-White residue hydrophobicity 

• New Ensemble Docking functionality, for considering active site flexibility when alternative active site 

conformations of the same protein are available 

• New Filter window, to show in the Ligands table only the ligands that conform to a desired set of rules. 

Includes filtering on numerical values, text data, Boolean values, tags, ligand structure using either a 

SMARTS string or a substructure sketched into the Flare Molecule Editor 
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• New Storyboard window, to capture scenes recording all details from the 3D window that can easily be 

recalled when needed, including the capability to annotate and rename scenes 

• New Radial Plot in the Ligands table to support Multi-Parameter Scoring 

• New 3D-RISM Surfaces button, to recalculate and display 3D-RISM surfaces when a completed 3D-RISM 

analysis is available for the selected proteins 

• New ‘Promote Pose to Ligand’ menu button to promote a chosen docked pose to ligand status 

• New ‘Delete Docking Grid on Selected Proteins’ function to delete unused docking energy grids, 

reducing the amount of disk space in the saved Flare project 

• New spherical clipping of protein surfaces 

• New border text displaying relevant information at the edge of the 3D window, especially useful when 

working in grid mode 

• New ‘Export all proteins’ functionality 

• New export file format for proteins as PDB files with Amber conventions 

• New export of ligand field surfaces 

• New ‘Move to protein’ menu button to merge a ligand to a chosen protein structure 

• New button in Flare Appearance Preferences to swap color of Cresset fields (blue/red) 

• Updated Lead Finder and Build Model algorithms  

• Updated sire (which contains WaterSwap) to version 2018.1.0  

• Updated AmberTools to version 18 

• Updated RDKit to version 2018.03.1 

• Improved protein superimposition now allowing the superimposition of all proteins vs. selected 

proteins 

• Improved coloring of crystallographic water molecules according to calculated 3D-RISM G 

• Improved WaterSwap workflow 

• Improved weighting scheme for consensus calculated free energy of binding from WaterSwap runs 

• Improved functionality of Protein Surfaces window, now enabling the update of saved protein field and 

molecular surfaces in terms of transparency, quality and chains included  

• Improved definitions for ligand-protein interactions, as fully documented in the Flare manual 

• Improved import of peptides as ligands 

• The FieldEngine binary now enables the setting of the maximum number of cores the process should 

use 

• Improved performance of multi-threaded docking runs 

• Improved layout of the functions in the Protein tab 

• Improved display of protein entries in the Protein table: the protein name is now the PDB code/file 

name for the protein; name column is resizable; background color for the ‘visibility’ icon matches the 

color of protein carbon atoms 

• Improved right-click menus 

• Improved ‘mark as favorite’ behavior for ligands 

• Improved functionality for moving all/chosen ligand(s) from protein(s) into the Ligands table 

• Improved logging for most functions 

• Improved ligand minimization, protein preparation dialogs 

• Improved clipping of front and back Z-planes in the 3D window, now allowing to choose whether the 

ligands should be affected by the clip planes 

• Improved Flare shortcuts 

• Lots of additional improvements and bug fixes. 



Flare release notes V5.0 

July 5, 2021 © Cresset  21 

Version 1.0 

• Initial release of Flare. 

File Format Compatibility 

Flare project files saved with a minor version of Flare can be read by any version of Flare with the same 

minor version number. For example, a Flare project file saved with Flare 4.0.2 can be opened with 4.0, 

likewise a Flare project file saved with Flare 4.0 can be read with 4.0.2. 

Newer versions of Flare can open any project file saved with an older version of Flare. For example, Flare 

5.0 can open Flare 2.0 project files. 

Flare can save project files as an older format by selecting ‘File’ → ‘Save Project As’ and setting the ‘Save as 

Type’ to the previous version. For example, Flare 5.0 can save a Flare 4.0 project file. 

Flare can also read the following data from Forge/Torch projects:  

• Ligands 

• Conformations 

• Alignments 

• The protein 

However, the following data will not be imported: 

• Field points on ligands and conformations 

• QSAR Models 

• Activity Miner data 

• Constraints 

• FieldTemplater projects 

The reason for this is that Flare unlike Forge/Torch uses a distance-dependent dielectric (DDD) in field 

calculations: mixing Flare field points with field points from Forge/Torch is scientifically invalid. For the 

same reason, alignments should be rescored to recalculate the similarity values using DDD fields. 

Uninstalling Flare 

Windows 

Flare can be uninstalled using the standard ‘Programs’ Control Panel shortcut.  

1. In the search box on the taskbar, type Control Panel and select it from the results. 

2. Select Programs > Programs and Features. 

3. Press and hold (or right-click) on the Flare icon and select Uninstall, then follow the directions on the 

screen. 

Linux 

If Flare was installed from a rpm package, it can be uninstalled with one of the following command lines, 

depending on whether it was installed with the rpm or yum command: 

rpm -e cresset-flare-<vers>-1.<arch> 
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or 

yum erase cresset-flare-<vers>-1.<arch> 

If Flare was installed by unpacking a tar.xz file, it will be sufficient to remove the Flare folder from the 

disk. 

macOS 

In the Finder sidebar, click Applications. Drag the Flare icon from the Applications folder to the Trash 

(located at the end of the Dock). 

Known Issues and Bugs 

• Flare may crash on MacBook Pro using the Intel Iris Plus graphics chip, and on Windows with some Intel 

graphics chips, due a bug in the graphics driver. On Windows, updating the graphics driver generally 

solves the issue.  

• GIST calculations fail at the end of the molecular dynamics stage if the protein name/title contains a 

space 

• Flare process fails to end when Flare is closed on Windows virtual machines with VMware Tools version 

11301 (11.1.5) installed. This issue may affect installation of Flare 5 while replacing existing installation 

of Flare on a Windows virtual machines with VMware Tools. As a workaround, once the uninstallation 

of existing Flare is complete, kill the Flare process manually and then proceed with new installation of 

Flare. 

• In some occasions, Flare may experience a critical error when running ligand-based alignment 

experiments on ligands containing metals  

• In some rare occasions, FEP in Flare may fail to generate a correct atom mapping for pseudosymmetric 

ring substituents. It is recommended to visually check, and if appropriate manually correct, the atom 

mapping using the Atom Mapping function on the FEP project tab menu 

• Flare may not operate optimally on remote systems like Citrix Virtual Apps. For optimal user 

experience, it is recommended to run Flare locally 

• Optimal performance for GPU calculations in Flare is achieved with NVIDIA CUDA: please install the 

latest NVIDIA GPU drivers to use CUDA. OpenCL is generally slightly less performant (~2-5%) but is 

available for non NVIDIA GPUs.  

• On some occasions, Flare may experience a critical error on laptops with a Wacom pressure-sensitive 

pen and touch screen. Disabling the Wacom pen driver solves the issue. 

• Flare will crash when the File dialog is opened if ‘Dell Backup and Recovery Application’ between 

versions 1.7.5.64 and 1.9.2.8 (list not inclusive) is used on your computer 

• The 3D window may not work smoothly in the Windows, Linux and macOS environment when using 

very large desktops. The workaround for this issue is to set the environment variable 
QT_AUTO_SCREEN_SCALE_FACTOR=0 

• The active stereo (Quad Buffer) on Windows 10 may not work on older graphic cards, due to limitations 

of the NVIDIA graphic driver. 

Found a bug or problem that is not listed? Please contact us and help improve our software! 

Third party software 

A range of open source and free software libraries and executables are incorporated in each Flare 

installation. License agreement information for each third party software can be found in the 

mailto:support@cresset-group.com?subject=Flare%20bug
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'documentation' subdirectory of the Flare installation directory and at https://www.cresset-

group.com/products/third-party-licenses/. Contact us at support@cresset-group.com if you wish to obtain 

the source code for any open source component. 

Support 

Cresset  
New Cambridge House 
Bassingbourn Road 
Litlington 
Cambridgeshire, SG8 0SS, UK 

+44 (0)1223 858890 
support@cresset-group.com 
www.cresset-group.com 
Twitter: @cressetgroup 
LinkedIn: Cresset group 

https://www.cresset-group.com/products/third-party-licenses/
https://www.cresset-group.com/products/third-party-licenses/
mailto:support@cresset-group.com?subject=Third%20party%20software
mailto:support@cresset-group.com
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http://twitter.com/cressetgroup
http://www.linkedin.com/groups?gid=3036251

